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Cíle  

V tomto pracovním listu: 

– se student seznámí s teorií nezbytnou pro pochopení principů pokročilých metod tematické kar-

tografie (metoda izolinií, tečková metoda, dasymetrická metoda), 

– naučí se rozlišovat, jaká data jsou pro zpracování jednotlivými metodami vhodná, 

– na cvičných datech si vyzkouší tvorbu map s užitím popisovaných metod.  

Izolinie 

Terminologický slovník zeměměřictví a katastru nemovitostí [1] definuje izolinie (též izočáry) jako 

„čáry spojující body o stejné hodnotě spojité proměnlivé veličiny“. Tato definice je běžně užívána 

v odborné i laické veřejnosti a je-li navíc doplněna vhodnou ilustrací (viz Obrázek 1), poskytuje ucele-

nou představu o tom, co pojem izolinie představuje. Někteří autoři ale považují uvedený výklad za 

nesprávný nebo přinejmenším nedostatečný. Například Dušek [2] poukazuje na fakt, že úsečka, spo-

jující v mapě dva libovolně vzdálené vrcholy o stejné nadmořské výšce izolinií není, ačkoliv je 

s předloženou definicí v souladu. Zavadí proto definici novou, dle které „je izolinií čára tvořená body 

o stejné hodnotě nějakého jevu“. 

 

Obrázek 1. Princip izolinií. V horní části obrázku jsou izolinie zachyceny v 2.5 pohledu. Ve spodní části je vidět 

jejich obraz ve 2D rovině mapy [6]. 
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Metoda izolinií se používá pro znázorňování kvantitativních dat. Základním předpokladem pro vy-

tvoření izolinií je spojitost sledovaného jevu. Jako příklad spojitého jevu lze uvést teplotu vzduchu, 

neboť platí, že v libovolném bodě mapovaného území bychom byli schopni tuto veličinu změřit (není 

žádný bod, kde by daný jev neexistoval). Dalším příkladem může být nadmořská výška reliéfu, rych-

lost větru, tlak vzduchu, výška sněhové pokrývky, salinita mořské vody apod. V důsledku spojitosti 

jevu se izolinie nikdy nemohou křížit. 

Druhou nezbytnou podmínkou je, aby hodnoty mapovaného jevu nebyly v prostoru konstantní. 

Bude-li například teplota vzduchu v celém zájmovém území totožná, nebude ji možné izoliniemi vy-

jádřit. Na druhou stranu se nabízí otázka, do jaké míry má smysl jev, jenž se v prostoru nemění, vůbec 

mapovat. V opačném případě, tedy pokud se jev prostoru mění příliš rychle, vznikají komplikace 

v podobě slévání izolinií. Vhodnou ilustraci nabízí mapy výškopisu, kde ke slévání dochází v místech, 

na nichž je svah příliš strmý či kde se nacházejí kolmé stěny a skály. V takových případech se izolinie 

buď na nezbytně nutnou dobu přerušují, nebo jsou v kritickém úseku nahrazeny jiným kartografickým 

znakem (viz Obrázek 2). 

 

Obrázek 2. Výřez ze Základní mapy ČR, 1 : 10 000 [7]. 

 

Podrobnost, s jakou je sledovaný jev izoliniemi vyjádřen, je dána jejich hustotou. Čím větším po-

čtem izolinií území pokryjeme, tím podrobnější představu o rozložení jevu uživatelé mapy získají. 

Tento počet je dán tzv. základním intervalem, který se vždy počítá od stanovené referenční (nulové) 

hodnoty. U výškopisu od nulové nadmořské výšky, u znázornění batymetrie od hladiny příslušné vod-

ní plochy, u znázornění teplot od izotermy 0 °C apod. V souvislosti se základním intervalem lze pozo-

rovat dvě problematické situace. První, je-li základní interval příliš malý. Vrstevnic je v takovém pří-

padě příliš mnoho a dochází k jejich slévání do souvislých ploch. A druhou, je-li interval naopak velký 

a pokrytí izoliniemi je nedostatečné. 
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I když zvolíme optimální základní interval, je třeba mít na paměti fakt, že izolinie graficky silně za-

plňují vytvářenou mapu. Citlivě je třeba postupovat zejména u map, kde má být současně s izoliniemi 

použit ještě jiný kartografický vyjadřovací prostředek. 

Za účelem rychlejšího přenosu informace, lze izolinie graficky rozlišit tak, že linie odpovídající ur-

čitému násobku, zdůrazníme. Ukázkou může být opět Obrázek 2, kde je zdůrazněná každá pátá vrs-

tevnice. Povšimněte si také, že zdůrazněné izolinie se nepřerušují. Pro snadnou interpretaci izolinií je 

dále velice užitečný jejich popis pomocí číselných kót. Ten se v české kartografické praxi umisťuje tak, 

že hlava číslic směřuje k vyšším hodnotám jevu, kupříkladu u vrstevnic do kopce. Popis se zarovnává 

na střed izolinie a čára se pod popisem přerušuje. 

Barva izolinií je dána především asociativností k danému jevu a není vázána striktními pravidly. 

V Česku je standardem zakreslovat vrstevnice hnědě. Výjimkami jsou specifické případy jako vrstev-

nice procházející po ledovci, pro něž se užívá modré barvy. Izobáty a jevy spojené se srážkami se kres-

lí modře. Popis se obvykle realizuje ve stejné barvě jako linie. 

Název izolinie Vysvětlení (čím je izolinie tvořena) 

izohypsa (vrstevnice) body o stejné nadmořské výšce 

izobáta body o stejné hloubce 

izobara body o stejné hodnotě atmosférického tlaku 

izoterma body o stejné hodnotě teplotě 

isotacha body o stejné rychlosti větru, vody apod. 

isohyeta body o stejném objemu atmosférických srážek 

isochrona body se stejným časem výskytu sledovaného jevu 

Tabulka 1. Seznam často používaných izolinií. 

 

Rozsáhlejší přehled týkající se terminologie izolinií lze nalézt v [5]. 

Interpolace 

V ideálním případě by každá izolinie měla procházet přesně místy, kde sledovaný jev nabývá konkrét-

ní hodnoty, jež je izolinií reprezentována. Aby toto bylo možné, museli bychom znát hodnotu jevu ve 

všech místech jeho výskytu (protože jde o spojitý jev, tak ve všech bodech mapovaného území). 

V praxi jsou ale hodnoty jevů měřeny pouze na určitém počtu vybraných míst (meteorologické stani-

ce, stanoviska měření sněžnou sondou atd.) nebo metodami DPZ, produkujícími výstupy v podobě 

diskrétních rastrů. Abychom splnili podmínku spojitosti jevu, dochází před konstrukcí izolinií k mate-

maticko-statistickému modelování rozložení sledovaného jevu, nazývaného též interpolace. Takto 

získáváme z naměřených diskrétních dat opět spojitou plochu, nezbytnou pro tvorbu izolinií. Vždy je 

třeba mít na paměti, že interpolace poskytuje pouze odhad rozložení daného jevu a nikoliv jeho 

přesné hodnoty. 

Zjednodušeně lze tedy říci, že interpolací rozumíme postup, který modeluje rozložení sledované 

veličiny/jevu v místech, kde nedošlo k jejímu/jeho přímému měření. Pokud máme například data 

o teplotě vzduchu z meteorologických stanic, interpolací se snažíme odhadnout, jaké teploty vzduch 

dosahoval v libovolném bodě mezi těmito stanicemi. Interpolačních metod je mnoho a většina je 
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navíc adaptovatelná řadou vstupních parametrů. Jejich podrobný popis zdaleka přesahuje rámec 

tohoto textu, a proto se budeme tomuto tématu věnovat jen do takové míry, aby byly zřejmé základ-

ní principy, na nichž interpolace stojí. Zájemcům o hlubší studium této problematiky lze doporučit 

předmět Interpolace prostorových dat, jehož výuku na PřF UK zajišťuje Ústav aplikací matematiky 

a výpočetní techniky. 

Cílem všech interpolačních technik je co nejpřesněji odhadnout rozložení sledovaného jevu. Růz-

né interpolační metody jsou vhodné pro různé typy sledovaných jevů. Vždy ale platí, že bez ohledu na 

použitou interpolační metodu je přesnost výstupu dána primárně přesností vstupních dat, jejich hus-

totou a jejich konfigurací (prostorovým rozložením). Je zřejmé, že by bylo chybou interpolovat napří-

klad teplotu vzduchu v Peci pod Sněžkou pouze z dat naměřených na vrcholu Sněžky a Černé hory (viz 

Obrázek 3. Poloha Sněžky, Černé hory a Pece pod Sněžkou. Ukázka příliš malé hustoty vstupních dat 

pro interpolaci teploty vzduchu), neboť lze předpokládat, že 500metrový rozdíl v nadmořské výšce 

bude mít na teplotu zcela zásadní vliv. V takovém případě by použití interpolace bylo chybné a vý-

sledné izolinie by podávaly chybné informace.  

 

Obrázek 3. Poloha Sněžky, Černé hory a Pece pod Sněžkou. Ukázka příliš malé hustoty vstupních dat pro 

interpolaci teploty vzduchu [8]. 

 

Za nejjednodušší interpolační metodu lze považovat lineární interpolaci, kdy se mapované území 

rozdělí na trojúhelníky (triangulace), jejichž vrcholy se nachází v místech, kde došlo k měření zkou-

mané veličiny. U lineární interpolace se předpokládá, že se mapovaná veličina mezi jednotlivými vr-

choly mění lineárně, díky čemuž není složité určit, kudy mají izolinie reprezentující konkrétní hodnoty 

procházet. Princip lineární interpolace ilustruje Obrázek 4. Izolinie představující hodnotu 100 prochá-

zí přesně v polovině spojnice mezi vrcholy s hodnotami 90 a 110, v jedné třetině vzdálenosti od vr-

cholu 105 mezi vrcholy 105 a 90 atd. Představíme-li si navíc jednotlivé trojúhelníky jako části rovin, 

procházejícími vždy vybranými třemi body, lze na základě znalosti obecné rovnice této roviny stanovit 

hodnotu mapovaného jevu v libovolném bodě mapovaného území. 
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Obrázek 4. Lineární interpolace. Ukázka výpočtu polohy izolinie reprezentující hodnotu 100 [9]. 

 

Z Obrázek 4 je také patrné, že izolinie vytvořené na základně lineární interpolace jsou lomenou 

čarou (přerušovaná černá linie). Pokud mají izolinie reprezentovat jev, který se v prostoru mění ply-

nule, pak se před zakreslením do mapy jejich průběh vyhladí (červená plná linie). 

Největší výhodou lineární interpolace je její výpočetní jednoduchost. Obecně lze lineární interpo-

laci doporučit v případě, že máme obrovské množství vstupních dat, které velice detailně pokrývají 

mapované území (typickým příkladem jsou data z laserového skenování). Jediným vstupním parame-

trem ovlivňujícím průběh izolinií je způsob triangulace, neboť platí, že mezi čtyřmi body, jež neleží na 

jedné přímce, lze dva trojúhelníky vykreslit vždy dvěma způsoby. 

Další metodou, která má velmi široké využití, je metoda Natural Neighbor. Pro pochopení této 

metody je nejprve třeba vysvětlit pojem Voroného diagram (někdy též Thiessenovy polygony). Tímto 

termínem se označuje geometrická struktura, která dělí prostor mezi určitými body (v našem případě 

body měření) na mnohoúhelníkové buňky. V každé této buňce leží právě jeden bod a platí, že které-

koliv místo uvnitř buňky je nejblíže právě příslušnému bodu. Z tohoto popisu logicky vyplývá, že hra-

nice mezi buňkami jsou vedeny tak, že hraniční čáry jsou ve stejné vzdálenosti od dvou sousedních 

bodů. Při pohledu na Voroného diagram na obrázku Obrázek 5 lze říci, že všem bodům uvnitř žlutě 

vybarvené buňky je nejblíže bod B, všem bodům uvnitř modré buňky bod A a hranice mezi těmito 

dvěma buňkami leží přímo v polovině vzdálenosti mezi body A a B. Obdobně je tomu u ostatních, 

neoznačených bodů. 

 

Obrázek 5. Voroného diagram. 
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Vytvoření Voroného diagramů je základem interpolační metody Natural Neighbor. Nyní přejděme 

k samotné interpolaci, tedy k otázce, jak zjistit hodnotu mapovaného jevu v libovolném bodě zájmo-

vého území. Předpokládejme, že interpolujeme teplotu vzduchu a že bychom chtěli odhadnout teplo-

tu v místě, jehož poloha je na obrázku Obrázek 6 označena zeleným bodem. V prvním kroku bychom 

pro tento bod vytvořili novou buňku Voroného diagramu, dle pravidel uvedených výše. Následně 

bychom analyzovali překryv nové buňky s původními buňkami. Z obrázku je vidět, že nová buňka 

překrývá původní buňky čtyř sousedních bodů. Z plochy překryvu bychom určili váhy jednotlivých 

bodů. Pro bod, ve kterém byla naměřena teplota 15 °C platí, že jeho původní buňka překrývá 51 % 

nové buňky zeleného bodu. Váha tohoto bodu tudíž bude 0,51. Podobně bychom vypočetli i váhy 

ostatních bodů. Závěrečný výpočet je váženou sumou teplot dotčených sousedních bodů. Konkrétní 

podoba výpočtu by vypadala následovně: 

𝑇𝑖𝑛𝑡 = 0,51 ∙ 15 + 0,21 ∙ 13 + 0,19 ∙ 16 + 0,01 ∙ 14 

𝑇𝑖𝑛𝑡 = 13,56 °C  

 

Obrázek 6. Natural Neighbor. Černým písmem jsou uvedeny teploty naměřené v jednotlivých bodech. Zele-

ným písmem váhy jednotlivých bodů. 

 

Při interpolování metodou Natural Neigbor v aplikacích GIS se nad celým zájmovým územím nej-

prve vytvoří rastr s dostatečně velkým prostorovým rozlišením (Obrázek 7, vlevo) a výpočet se prová-

dí pro všechny pixely v rastru. Poté se dle zadaného základního intervalu stanoví průběh izolinií (pixe-

ly o požadované hodnotě se spojují liniemi). V poslední fázi se izolinie převedou do vektorové 

podoby, vykreslí se a vyhladí se jejich průběh, čímž se zvýší estetická hodnota výstupu (Obrázek 7, 

vpravo). 
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  Obrázek 7. Rastr vytvořený interpolačním algoritmem v GIS (vlevo). Vygenerované, 

vyhlazené izolinie (vpravo). 

 

Kromě lineární interpolace a metody Natural Neighbor jsou velmi často používány také metody 

Spline, IDW či Kriging. V tomto studijním materiálu není prostor pro jejich podrobný výklad, který je 

značně složitý. Vždy však musí platit, že užití některé z metod předchází pochopení jejích principů. 

Jinak může dojít nejen k chybnému výběru metody, ale také k získání chybných výsledků. 

Přestože jsou izolinie velice často používanou metodou, jsou v oboru kartografie předmětem zá-

sadních sporů. V řadě kartografických publikací (např. [3], [4]) jsou izolinie rozlišeny na pravé a ne-

pravé (též pseudoizolinie). „Pravými“ izoliniemi jsou nazývány ty, které zachycují průběh spojitých 

jevů tak, jak je popsáno v úvodu tohoto studijního materiálu. Označení „nepravé“ náleží izoliniím, 

které vyjadřují rozmístění nespojitých jevů. Jako příklad nespojitého jevu lze uvést průměrnou cenu 

bytů v obcích, hustotu zalidnění, míru nezaměstnanosti, počet vysokých škol v regionu atd. 

Používání pseudoizolinií je přitom přinejmenším sporné, neboť aplikace izolinií pro reprezentaci 

nespojitých jevů je z principu chybná a neměla by být vůbec akceptována. Pseudoizolinie razantně 

odmítá například Dušek [2], který uvádí, že „základním cílem kartografické vizualizace by mělo být 

graficky znázorňovat geografická data tak, aby mohla být uživatelem snadno rozpoznána a interpre-

tována“ a o pseudoizoliniích píše, že „jako metoda, která v celé ploše mapy udává pro jev jiné hodno-

ty, než jakých ve skutečnosti nabývá, je jen obtížně obhajitelná“. 

Pro pochopení toho, proč není použití izolinií vhodné pro nespojité jevy, poslouží následující pří-

klad. Předpokládejme, že bychom vytvořili izolinie z dat o cenách bytů ve vybraných městech a získali 

bychom výstup podobný tomu na obrázku 8. Tato dvě města tudíž logicky spadají do oblasti ohrani-

čené izolinií obepínající nejtmavěji vybarvený areál. Pokud by tato izolinie reprezentovala hodnotu 

4 mil. Kč, mohly by ceny bytů ve městech A a B být např. 4,1 a 4,3 mil. V případě, že bychom izolinie 

vykreslovali po 0,5 mil. Kč, mohly by ceny bytů ve zbývajících dvou městech dosahovat 3,3 

a 3,2 mil. Kč. 
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Nyní si představme, že v oblasti ohraničené červenou linií se nachází les či jiná neobydlená plo-

cha. Na základně nevhodně použité metody izolinií tak získáváme výsledek, že uprostřed lesa, kde se 

nenachází žádná zástavba, jsou podobně drahé byty jako ve dvou nejdražších městech. Již na první 

pohled se jedná o výsledek nesmyslný. Neobstojí přitom ani připomínka, že nevhodný výsledek je 

důsledkem nedostatečně podrobných/hustých vstupních dat, neboť tím, že uprostřed lesa žádné byty 

neexistují, nedává smysl zde jakákoliv data pořizovat (zjišťovat jejich cenu). 

 Obrázek 8. Ilustrace chybného použití metody izolinií na příkladu mapy cen bytů (vlevo). Zavádějící mapa 

časové dostupnosti (vpravo). 

 

Dalším častým příkladem problematického užití metody izolinií jsou mapy časové dostupnosti (viz 

obrázek Obrázek 8, vpravo). Při výpočtu časové dostupnosti se uvažuje pouze pohyb po liniové síti 

(síť silnic, železnic, linek MHD apod.) a ani v tomto případě se tedy nejedná o jev spojitý. Vypočtená 

dostupnost pak dává smysl pouze v místě, kde izolinie přetíná liniovou síť. Ve zbytku mapovaného 

území jsou vypočtené hodnoty zavádějící. 

Jediným akceptovatelným případem použití izolinií nad nespojitými daty je jejich využití pro vi-

zualizaci naměřených dat pořízených DPZ a prezentovaných rastrem (např. data o oblačnosti). Tato 

data jsou také částečně nespojitá (data představují průměry za jednotlivé pixely). Je-li však prostoro-

vé rozlišení rastrů dostatečné, na výsledku se zmíněný problém v podstatě neprojeví. 

Praktická realizace v ArcGIS for Desktop 

Praktická ukázka bude realizována na datech z batymetrického výzkumu tůní v PR Meandry Lužnice. 

Jak vyplývá z teoretické části, tvorbě izolinií v GIS předchází v drtivé většině případů interpolace. 

V programu ArcMap jsou jednotlivé interpolační funkce sdruženy v Arc Toolboxu, ve skupině nástrojů 

Spatial Analyst Tools, pod souhrnným označením Interpolation. V návaznosti na předchozí text využi-

jeme interpolátoru Natural Neighbor. 

Dialogové okno pro zadávání vstupních parametrů je velice jednoduché (obrázek Obrázek 9). Je-

diný parametr, který zásadně ovlivňuje výsledek, je požadovaná velikost pixelu vytvářeného rastru. 

Čím menší velikost zadáme, tím podrobnější rastr získáme. Na druhou stranu, se zmenšující se veli-
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kostí pixelu roste jejich celkový počet v rastru (rozlišení), a tudíž i výpočetní náročnost a nároky na 

místo na disku. Proto je třeba najít přijatelný kompromis. V našem případě je dostačující hodnota 0,2. 

Sloupec, ve kterém jsou uvedeny údaje o hloubce tůně, se jmenuje „hloubka“ a zadáváme jej do pole 

Z value field. Přestože pro vytvoření izolinií je třeba učinit ještě několik kroků, již v této fázi můžeme 

obarvit rastr vhodnou kvantitativní stupnicí barev a získat jasnou představu o rozložení sledovaného 

jevu. 

 

Obrázek 9. Interpolace Natural Neighbor v programu ArcMap. 

 

Izolinie, v podobě liniových dat, vygenerujeme pomocí nástroje Contour (Spatial Analyst Tools > 

Surface > Contour). Základní interval izolinií je dán parametrem Contour Interval. Parametr Base Con-

tour udává, jakou hodnotu má reprezentovat základní izolinie, od níž se budou počítat ostatní linie. 

Pokud bude interval izolinií nastaven na hodnotu 2 a základní izolinií bude hodnota 0, pak budou 

vytvořeny izolinie o hodnotách 0, 2, 4, 6 atd. Bude-li však základní izolinie procházet hodnotou 1, 

dostaneme izolinie o hodnotách 1, 3, 5, 7 atd. Pro naši úlohu zadejme základní interval 0,5 a základní 

izolinii 0 (Obrázek 10). 

 

Obrázek 10. Vygenerování izolinií. 
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Protože interpolační algoritmy neumí extrapolovat, může nastat situace, že v oblastech, v nichž 

nemáme k dispozici žádná data, budou izolinie různě zdeformované. Z obrázku Obrázek 10 je zřejmé, 

že v našem případě k tomuto problému dochází vně břehové linie, kde izolinie vyjadřující hodnotu 0 

tvoří jakési zřetězené oblouky. Z tohoto důvodu je vhodné vytvořené linie oříznout tak (např. funkcí 

Clip), aby se nacházely pouze v místech, která jsou pokryta daty. 

V případě, že jsou vytvořené izolinie příliš „hranaté“, je možné je vyhladit generalizační funkcí 

Smooth Line (Arc Toolbox > Cartography Tools > Generalization > Smooth Line). Druhou užitečnou 

funkcí je Simplify Line (Arc Toolbox > Cartography Tools > Generalization > Simplify Line), která zjed-

nodušuje průběh tvarově příliš složitých linií. Obě funkce je nutné používat uvážlivě, aby nedošlo 

k zásadním změnám v poloze linií, a tudíž ke ztrátám přesnosti mapy. 

Rozlišení základních a zdůrazněných izolinií ArcMap explicitně neumožňuje. Tato úloha je však 

velmi snadno řešitelná několika způsoby. Možným řešením je vytvoření nového sloupce v atributové 

tabulce vrstvy s izoliniemi, který pojmenujeme např. ZDURAZNENE a který bude datového typu Short. 

Poté pro tento sloupec spustíme Field Calculator, jako Parser zvolíme Python a aplikujeme výraz „1 if 

!Contour!%2 == 0 else 0“. Zadaný výraz lze interpretovat tak, že hodnota ve sloupci ZDURAZNENE má 

být rovna 1, pokud je zbytek po vydělení hodnoty ve sloupci Contour dvojkou roven nule. V ostatních 

případech se do sloupce ZDURAZNENE zapíše 0. Uvedený případ samozřejmě platí pouze v případě, 

že má být zdůrazněná každá druhá izolinie. Pokud by to měla být například každá pátá, byla by ve 

výrazu dvojka nahrazena pětkou. Poté stačí na kartě Symbology v dialogovém okně vlastností vrstvy 

(Layer Properties) zvolit možnost Categories a izolinie, jejichž hodnota je ve sloupci ZDURAZNENE  

rovna 1, vykreslit silnější linií. 

Popis kartografických znaků, včetně izolinií, je rozebrán v pracovním listu Popis. Výsledná podoba 

může vypadat jako na Obrázek 11. 

Obrázek 11. Výsledná podoba izolinií. 
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Tečková metoda (Metoda teček) 

Tečková metoda slouží k vyjádření kvantitativních dat absolutní povahy, např. rozmístění osob, koste-

lů, sklizených tun pšenice, kusů skotu apod. Čtením map, na nichž je tato metoda použita, získáváme 

informaci o hustotě sledovaného jevu v prostoru. Jinými slovy, mapy nám prostřednictvím tečkové 

metody sdělují, kde je koncentrace jevu vyšší a kde je tomu naopak. Chybou by bylo pokoušet se 

z mapy vyčíst kolik jednotek jevu (osob, kostelů, sklizených tun pšenice, kusů skotu apod.) se 

v konkrétním území nachází a kde přesně jsou lokalizovány. Vzhledem ke způsobu předávání infor-

mace skrze vnímání hustoty teček na dané ploše je žádoucí používat pro tečkové mapy plochojevná 

zobrazení. Příklad aplikace této metody je vidět na Obrázek 12. 

 

Obrázek 12. Ukázka aplikace tečkové metody [10]. 

 

Kvantita jevu v mapě je vyjádřena malými body, které se označují termínem kvantifikační tečky. 

Před vytvořením teček řeší kartograf tři zásadní problémy: váhu teček, velikost teček a polohu teček. 

Váha jednotlivých teček vypovídá o tom, kolik jednotek jevu je reprezentováno jednou tečkou. 

Nejjednodušší je situace, kdy množství jevu a měřítko mapy umožňují zakreslení každé jednotky jed-

nou tečkou (1 kostel = 1 tečka). Tečková metoda v takovém případě degeneruje na prostou metodu 

bodových znaků. V případě, že začne docházet k překrývání jednotlivých teček, takže tečky nelze na-

dále vizuálně rozlišit, je třeba stanovit vyšší váhu, čímž se výsledný počet teček sníží. Jedna tečka tak 

může reprezentovat 2, 5, 10 či více jednotek.  

Se zvyšováním váhy tečky je třeba sledovat, nejen zda se daří eliminovat překrývání teček, ale ta-

ké jestli v mapě nevznikají místa s příliš řídkým výskytem teček, či zcela bez teček. Problematické je 

v tomto směru zejména znázorňování socioekonomických jevů vázaných na sídla, kde koncentrace 

jevu řádově převyšuje jeho koncentraci mimo sídla. V těchto situacích někteří autoři volí použití teček 

různé velikosti. Větší tečky mají logicky vyšší váhu. Tečková metoda se pak stává bodově lokalizova-

ným, bodovým, součtovým kartodiagramem s intervalovou stupnicí (obrázek Obrázek 13). 
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Obrázek 13. Případ, kdy tečková metoda přechází do podoby kartodiagramu [4]. 

 

K lokalizaci teček existují dva základní přístupy: kartogramový (též areálový či rovnoměrný) a to-

pografický. Kartogramový způsob je založen na pravidelném rozmisťování teček, nejčastěji do rohů 

pomyslné čtvercové sítě. Z obrázku Obrázek 14 je na první pohled viditelná podoba s kartogramem. 

Tuto podobnost dále umocňuje fakt, že rozmístění teček nemá v tomto případě žádnou lokalizační 

roli (tečky neleží v místech výskytu jevu) a je podřízeno pouze požadavku, vytvořit pravidelný vzor 

(rastr), jehož intenzita (hustota vzoru) vyjadřuje intenzitu mapovaného jevu. Způsob předávání geo-

grafické informace je tudíž u kartogramu i tohoto způsobu užití tečkové metody totožný a liší se pou-

ze způsob interpretace rastru na základě legendy. Protože použití kartogramu pro absolutní data 

může být zavádějící (podrobné zdůvodnění viz výukový list Kartogram), použití kartogramového způ-

sobu rozmisťování teček nelze příliš doporučit.  

 

Obrázek 14. Kartogramový způsob lokalizace teček [4]. 
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Jiný, vhodnější způsob umisťování teček se nazývá topografický. V takovém případě se tečky 

umisťují do míst, kde je vysoká pravděpodobnost výskytu daného jevu. Budeme-li vytvářet mapu 

restauračních zařízení, budou tečky logicky umístěny do plochy sídel a nikoliv tam, kde se nachází 

například vodní plocha či les. Pokud není váha tečky rovna jedné, je zřejmé, že tečka nebude nikdy 

přesně reprezentovat konkrétní restaurace. V takovém případě se snažíme umisťovat tečky do těžiště 

vycházejícího z polohy restaurací sdružených do jedné tečky.  

Topografické umisťování teček podává nejlepší představu o rozložení i hustotě sledovaného jevu. 

Na druhou stranu jde o způsob, který je velmi pracný, vytvoření mapy vyžaduje řadu vstupních pro-

storových analýz, je silně závislý na schopnostech kartografa, a v žádném z dostupných aplikací GIS 

není algoritmizovaný. Všechny naznačené problémy se navíc dále umocňují, jsou-li vstupní data vázá-

na na plochu, jako je tomu kupříkladu u statistických údajů vztažených k administrativním jednotkám. 

Už jen samotná úloha, jak nahradit polygon tečkou/tečkami tak, aby tyto co nejlépe zohlednily tvar a 

polohu polygonu, je značně komplikovaná. Z těchto důvodů není topografická lokalizace příliš použí-

vána a často se přistupuje k lokalizaci náhodné, kterou například program ArcGIS od ESRI podporuje. 

Náhodné rozmístění teček podá informaci o proměnlivé hustotě jevu, jde ale o způsob velmi ná-

chylný na dezinterpretaci. Obzvlášť u laické veřejnosti může docházet k chápání mapy tak, že jev se 

skutečně vyskytuje v místě teček, což je vnímání zcela chybné. Aspoň částečně se tomuto dá předejít 

vhodnější legendou, než jen uvedením věty že 1 tečka = n jednotek jevu (Obrázek 15Chyba! Nenale-

zen zdroj odkazů.). 

 

Obrázek 15. Doporučené zpracování legendy při použití náhodného rozmístění teček. 

 

Z předchozího textu je patrné, že tečková metoda vnáší do systému kartografických vyjadřovacích 

prostředků značný zmatek. Pro využití v praxi lze však reálně doporučit pouze topografický způsob, 

který je dostatečně intuitivní a nesvádí k chybné interpretaci, jako náhodně lokalizované tečky. Pří-

padně, umožňuje-li to situace, nahradit tečkovou metodu metodou bodových znaků či bodovým kar-

todiagramem. 
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Praktická realizace v ArcGIS for Desktop 

Pro praktickou ukázku tvorby tečkové metody byla použita data z monitoringu výskytu kormorána 

velkého v lokalitě Lahemaa Rahvuspark ze dne 11. 6. 2004. Výskyt každého monitorovaného jedince 

je v datech reprezentován jedním bodem. Referenční měřítko mapy bylo nastaveno na 1 : 120 000. 

Po nahrání do prostředí programu ArcMap jsou data automaticky vizualizována v podobě bodů, 

složených z obrysu a barevné výplně. Taková grafická podoba znaků je pro naše potřeby zbytečně 

složitá a je vhodné ji upravit. 

Vzhledem k tomu, že data o výskytu kormorána nejsou dále strukturovaná (podle stáří, pohlaví, 

apod.), zvolíme jednotný kartografický znak v podobě „jednoduché tečky“. Ani výběr barvy v tuto 

chvíli není klíčový, neboť o kormoránech nemáme k dispozici žádné další údaje, které bychom moh-

li/potřebovali barvou vyjádřit. Zvolíme tedy černou barvu. Základní úpravy provádíme v dialogovém 

okně Symbol Selector, pokročilejší možnosti definování znaku nabízí okno Symbol Property Editor, 

které lze z předchozího okna otevřít tlačítkem Edit Symbol (obrázek Obrázek 16). 

 

Obrázek 16. Dialogová okna Symbol Selector a Edit Symbol. 

V okně Edit Symbol si povšimněte zvoleného typu znaku Simple Marker Symbol. 

 

Pro další práci je nezbytné, aby typ znaku (Type), který zadáváme v okně Symbol Property Editor, 

byl vždy Simple Marker Symbol. Chybou je, pokud jako znak vybereme některý z nabízených znaků 

v okně Symbol Selector (např. Circle 1). Tyto znaky jsou definovány nikoliv jako geometrické obrazce, 

ale jako znaky určitého fontu, což způsobuje řadu problémů jako například nesoulad mezi nastave-

nou velikostí znaku a jeho skutečnou velikostí po vytištění mapy. 

Správné nastavení velikosti teček je klíčové pro snadnou čitelnost mapy. V tomto bodě záleží na 

citu a zkušenostech kartografa, aby zvolil takovou velikost, která bude kompromisem mezi vzájem-

nými překryvy bodů a čitelností celkového rozložení bodů. V našem modelovém příkladu lze za opti-

mální hodnotu volit velikost 4. 

Z výstupu, který jsme získali, je již distribuce sledovaného jevu jasně viditelná. Z kartografického 

pohledu je nadále žádoucí vyřešit shluky bodů tvořící černé skvrny (Obrázek 17). Pro snazší odhalení 

míst, v nichž ke shlukům dochází, je možné použít funkci NEAR (ArcToolbox > Analysis Tools > Pro-

ximity > Near). 
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Obrázek 17. Tečky tvořící nežádoucí shluky (vlevo). Detekce shluků pomocí funkce Near a jejich následné 

obarvení (vpravo). 

 

Vstupními parametry Input Features i Near Features bude v obou případech vrstva kormoran.shp. 

Jiné parametry není třeba zadávat. Funkce vytvoří v atributové tabulce zadané vrstvy sloupce 

NEAR_FID a NEAR_DIST. V prvním sloupci je uvedeno ID bodu, který je k bodu na příslušném řádku 

nejblíže. Ve druhém sloupci je zapsána konkrétní vzdálenost mezi těmito body. 

Ke stanovení kritické vzdálenosti, při níž začne docházet k překryvu znaků, využijeme znalost mě-

řítka mapy a definovanou velikost teček. Budeme-li uvažovat měřítko mapy 1 : 120 000 a velikost 

tečky 4 pts (1,41 mm), vyjde nám, že v geografických jednotkách zabírá tečka kruhové území o prů-

měru 169,3 m. Jinými slovy lze říci, že u bodů, které jsou k sobě blíž než tato vzdálenost, začne do-

cházet k překryvu znaků. Tyto body lze pro lepší přehlednost obarvit jinou barvou jako na obrázku 

Obrázek 17. 

Rozbití shluků na samostatné body není v programu ArcMap automatizováno a je třeba přistoupit 

k manuální editaci. Jedním řešením je „decentní“ posunutí bodů od sebe. Druhé řešení spočívá 

v nahrazení shluků většími znaky reprezentujícími více jednotek jevu najednou. Toto řešení nalezne 

uplatnění v případě, že pro posouvání znaků není v mapovém poli dostatek místa. 

Realizaci obou řešení lze provést buď s využitím kartografických reprezentací, nebo pomocí Edito-

ru. Kartografické reprezentace umožňují oddělit grafické znázornění dat (znaky) od dat samotných, 

takže při grafických úpravách zůstanou původní data nedotčena. V návaznosti na naši úlohu lze říci, 

že při posunu jednotlivých teček by došlo pouze k posunu kartografického znaku, aniž by byly dotče-

ny souřadnice výskytu daného jedince kormorána. Toto řešení je jednoznačně nejvhodnější. Proble-

matika kartografických reprezentací je ale natolik obsáhlá, že ji v rámci tohoto textu není možné ná-

ležitě probrat. 

Zaměříme se proto na druhou možnost, kterou je editace (posun) samotných dat. Protože dojde 

k zásahu do datových souborů, je vhodné tyto úpravy provádět na kopii dat a nikoliv na datech origi-

nálních. 

Spustíme Editor, zvolíme nástroj Edit Tool, vybereme bod, který chceme posunout a pohybem 

myši při stisknutém levém tlačítku mu definujeme novou polohu. Po dokončení editačních prací je 

třeba úpravy uložit (Save Edits) a ukončit editační mód (Stop Editing). Veškeré editace je vhodné pro-

vádět v módu Data View při nastaveném referenčním měřítku. Po dokončení úprav může výsledný 

výstup vypadat například jako na Obrázek 18. 
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Obrázek 18. Tečky po provedení manuálních posunů a nahrazení shluků tečkami s vahou 3. 

 

Dasymetrická metoda 

Cílem dasymetrické metody je areálově znázornit relativní kvantitativní data popisující nespojitý jev 

vztažený k ploše mapovaného území. Typickým příkladem je hustota zalidnění vztažená k 1 km2, podíl 

orné půdy na celkové výměře půdy, délka silniční sítě vztažená k 100 km2 apod. I přesto, že ke stej-

nému cíli směřuje také metoda kartogramu, jsou obě metody zásadně rozdílné. Základním znakem 

kartogramu je totiž znázorňování sledovaného jevu skrze předem definované územní jednotky. Již 

zmíněná hustota zalidnění se obvykle znázorňuje za obce, okresy, kraje atd. Tato administrativní re-

gionalizace je značně problematická, neboť nelze předpokládat, že by byl jev v celé ploše administra-

tivních jednotek rozmístěn rovnoměrně tak, jak jej ukazuje kartogram. Běžně naopak platí, že admi-

nistrativní jednotky jsou vnitřně silně nehomogenní (největší hustota zalidnění bude v sídlech, nulová 

bude naopak v místě vodních ploch apod.) a výsledky prezentované kartogramem jsou tudíž často 

silně zkreslené. Tento problém se navíc stupňuje s rostoucí rozlohou územních jednotek. 

Dasymetrická metoda se pokouší uvedený nedostatek kartogramu eliminovat tím, že jsou hranice 

areálů definovány až v průběhu tvorby mapy na základě prostorové analýzy rozmístění sledovaného 

jevu. Zjednodušeně řečeno se metoda pokouší definovat hranice areálů tak, aby byla hodnota sledo-

vaného jevu uvnitř areálů co nejhomogennější.  
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Dříve se dasymetrické mapy vytvářely na základně map zpracovaných tečkovou metodu. Nutným 

předpokladem bylo, aby tečky ve vstupní mapě byly rozmístěny topograficky (viz kapitola Tečková 

metoda). Cílem bylo rozdělit mapované území na oblasti se stejnou hustotou teček, tedy stejnou 

hustotou sledovaného jevu. Dnes lze pro takovou analýzu využít přímo digitální databáze prostoro-

vých dat a geoinformační software. Díky tomu se zcela redukuje riziko přenášení chyb, nepřesností 

a subjektivity, k nimž mohlo dojít při tvorbě tečkové mapy. Znatelně se také zkracuje čas, potřebný 

pro tvorbu dasymetrické mapy. 

V některých publikacích se dasymetrickou metodou označuje také způsob jakéhosi dodatečného 

zpřesnění kartogramu. Tento postup vychází z předpokladu, že různé typy krajiny silně ovlivňují roz-

místění jevu uvnitř administrativní jednotky. V případě zalidnění je logické, že jev se nebude vůbec 

vyskytovat v místech vodních ploch, v místech lesů se bude vyskytovat jen velmi zřídka. Vysoký hek-

tarový výnos pšenice nelze očekávat v místě sídel apod. Právě informace o krajině se kombinují 

s kartogramem a hodnota jevu se určuje pouze pro místa, kde se může reálně vyskytovat. Toto řešení 

lze nadále rozšířit o koeficienty výskytu u různých druhů krajiny. 

Praktická realizace v ArcGIS for Desktop 

Přestože v ArcMap žádný nástroj, který by přímo generoval dasymetrickou reprezentaci dat, neexis-

tuje, lze najít funkce, které se svým výstupem dasymetrické metodě blíží. 

Máme-li k dispozici vstupní data v podobě bodů, lze aplikovat funkce Point Density (Arc Toolbox > 

Spatial Analyst Tools > Density > Point Density) nebo Kernel Density (Arc Toolbox > Cartography Tools 

> Generalization > Aggregate Points). 

Point Density vytváří nad bodovými daty rastr, jehož každý pixel nese informaci o tom, kolik bodů 

se nachází v jeho okolí o definované velikosti. Princip výpočtu je patrný z Obrázek 19. Princip metody 

Point Density. Hodnota pixelu 1 bude odpovídat dvěma bodům v okolí pixelu. Pixel 2 má ve svém 

okolí jeden bod a pixel tři žádný bod..   

 

Obrázek 19. Princip metody Point Density. Hodnota pixelu 1 bude odpovídat dvěma bodům v okolí pixelu. 

Pixel 2 má ve svém okolí jeden bod a pixel tři žádný bod. 
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V rámci praktické ukázky můžeme funkci Point Density aplikovat na data z monitorování kormo-

rána, která jsme používali u tečkové metody. Na obrázku Obrázek 20 je zachycen výsledný rastr. Za-

daná velikost okolí byla v tomto případě 2 km. Velikost pixelu 50. 

 

Obrázek 20. Rastr hustoty vytvořený funkcí Point Density 

 

Na první pohled je zřejmé, že vygenerované areály s homogenní hustotou jsou značně roztříštěné 

a je tudíž nutné je dále zpracovat. Možným postupem je převedení rastru na polygony (ArcToolbox > 

Conversion Tools > From Raster > Raster to Polygon) a jejich následná generalizace (ArcToolbox > 

Cartography Tools > Generalization > Simplify Polygon). Na závěr může výsledek vypadat podobně 

jako na Obrázek 21. 

 

Obrázek 21. Výskyt kormorána velkého znázorněný dasymetrickou metodou. 
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Při tvorbě legendy je vhodné uvádět takovou velikost území, kterou jsme použili jako velikost 

okolí (resp. odpovídající plochu okolí). Pokud jsme v našem případě stanovili velikost okolí jako 2 km 

a uvážíme, že okolí má kruhový tvar, pak by měla legenda vyjadřovat počet kormoránů na 12,5 km2 

(obrázekObrázek 22). Uvádět v legendě údaje vztažené na 1 km2 by bylo správné pouze v případě, že 

bychom jako velikost okolí zadali 564,2 m (564,2 m je poloměr kruhového okolí s plochou 1 km2). 

 

Obrázek 22. Legenda k dasymetrické reprezentaci dat. 

 

Na podobném principu jako funkce Point Density pracuje také funkce Kernel Density. Při použití 

této funkce vstupuje do výpočtu navíc tzv. jádrový odhad hustoty. Výsledný rastr je pak simuluje 

podstatně hladší, vyhlazenější průběh funkce. 

Cvičení 

Úkol 

Z popsaných metod tematické kartografie (metoda izolinií, tečková metoda, dasymetrická metoda) 

vyberte tu nejvhodnější pro zpracování následujících datových sad. Správnou odpovědí může být více 

metod zároveň nebo naopak žádná metoda. Všechna data jsou bodového charakteru (může se jednat 

o centroidy, tj. středy území u dat plošného charakteru). 

1. Koncentrace podzemních zdrojů pitné vody (studny, vrty, prameny) na území Česka. 

2. Koncentrace oxidů dusíku 16. 1. 2017, v 14:00 SEČ, na území Prahy. Data pocházející ze zhuštěné 

sítě stanic měřících kvalitu ovzduší v Praze. 

3. Hustota porostu na lesních plochách v 1. zóně Národního parku Šumava. Data byla pořízena bě-

hem terénního šetření.  

4. Hustota sídel nad 500 000 obyvatel v Severní Americe. 

Řešení 

1. V daném kontextu je koncentrace chápána jako četnost výskytu na určité ploše. Data je možné 

znázornit tečkovou metodou (vyjádření absolutních dat) či dasymetrickou metodou (vyjádření re-

lativních dat vztažených k jednotce plochy). 

2. V tomto případě je koncentrací míněn podíl oxidů dusíku ve vzduchu (v jednotkách ppm). Cílem 

mapy není vyjádřit, kde bylo měřicích stanic nejvíce a kde nejméně, ale jaké bylo v době měření 

znečištění na celém území Prahy. Jedinou použitelnou metodou je metoda izolinií.  

3. Zde je hustota chápána jako parametr lesa, který lze sledovat na všech místech v lese a u kterého 

lze předpokládat, že se bude měnit. Vhodnou metodou je metoda interpolace. 

4. Typický příklad nespojitého jevu, u kterého se snažíme vyjádřit jeho rozložení v mapovaném 

území. Obdobně jako v prvním případě připadají v úvahu tečková metoda a metoda dasymetric-

ká.  
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